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What is PC-Telephone?

PC-Telephone  is a powerful communications software application that enables you to exploit the full 
communications potential of the Internet (IP) and the public telephone networks (ISDN/PSTN). PC-
Telephone makes possible to use your computer as a regular telephone, Internet telephone, fax machine, 
voicemail, file transfer and much more….
The Computer Telephony Integration technology implemented in PC-Telephone increases your 
productivity, saves your time and money and creates many positives for companies and private 
individuals alike. PC-Telephone is the first software application that integrates the regular Computer 
Telephony and Internet Telephony (Voice over IP) in a single user interface.

With the advanced Call     Transfer   capabilities PC-Telephone can also be used as a telephone exchange or
PBX between different communications networks – Internet/Intranet and ISDN/PSTN. The picture bellow 
shows the possible PC-Telephone connections:

Use PC-Telephone to make:
· PC-to-PC calls over Internet/Intranet

· PC-to-Phone/Fax calls over Internet

· PC-to-Phone/Phone-to-PC calls over ISDN

Use our calling cards to make PC-to-Phone/Fax calls worldwide!



PC-to-PC Calls over Internet/Intranet
Use PC-Telephone to make unlimited, FREE PC-to-PC calls over the Internet. Enter in the Phonebar the 
IP address or name of your contact party's PC and press the Dial button while you are online.

Your IP address is your Internet phone number. Find your current IP address in the IP address combo box
(Network-IP) after establishing the Internet connection. Most of the Internet service providers offer 
permanent IP addresses especially with DSL (Digital Subscriber Line) and Cable modems. If you, 
however, cannot arrange to have a static IP address, you can always use no-ip.com or tzo.com to get a 
FREE static name for your PC.

* If your PC is behind a NAT router (LAN users) your still can make FREE PC-to-PC and cheap PC-to-
Phone/Fax calls over Internet (see Voice     over     TCP/IP  ).

* If you like to receive PC-to-PC calls on your LAN computer, use your NAT (Network Address 
Translation) router and make port mapping for TCP/UDP 9084. You can also configure your ADSL router 
and set your PC to be a “Virtual Server”. All packets coming to ports TCP/UDP 9084 at the external IP 
address of your router should be forwarded to the same ports to the IP address of your LAN computer.

* If your computer is behind a Firewall, and the PC-Telephone ports are blocked, ask your network 
administrator to open the ports TCP/UDP 9084 in/out to allow making Intranet-Internet calls.

Make your website voice enabled. Install PC-Telephone and get FREE calls from your customers online.

Use our calling cards to make PC-to-Phone/Fax calls worldwide!



PC-to-Phone/Fax Calls over Internet
You can call regular phones from your Internet connection if you place your calls through a PC-Telephone
gateway. Dial in the Phonebar a phone number with the following format: ipaddress#phonenumber, where
“ipaddress” is the IP address or name of the PC-Telephone gateway your call is transferred by and 
“phonenumber” is the regular phone number you like to call.

Any PC-Telephone, including yours, can be a gateway and can transfer phone calls (see Call     Transfer  ). 
The PC-Telephone, which transfers phone calls from Internet to regular phones, must have both Internet 
and ISDN networks available.

Use our PC-Telephone gateways to transfer your regular phone/fax calls to more then 200 countries 
worldwide with exceptional audio quality and great low rates. The mobile phones are included.

Dial in the Phonebar: pctt.net#1234567890, where pctt.net is the IP address of our gateway and 
1234567890 is the regular phone/fax number you like to call (country code + area code + local phone 
number). The phone number should consist of only digits.

PC-Telephone works with all Firewalls, NAT and LAN routers – nothing to configure (see 
Voice     over     TCP/IP  ).

Use our calling cards to make PC-to-Phone/Fax calls worldwide!



PC-to-Phone/Fax and Phone/Fax-to-PC Calls over ISDN
If you have ISDN (Integrated Services Digital Network) card/modem connected to your ISDN telephone 
line, PC-Telephone turns your PC into a digital telephone/fax and you can use it in the same manner as 
you use your regular phone/fax now. You can make and receive phone/fax calls to/from any regular 
phone/fax, either digital or analog. Use digits only when you dial regular phone numbers.

The Common-ISDN-API (CAPI 2.0) is an Application Programming Interface standard used to access 
ISDN equipment connected to Basic Rate Interface (BRI) or Primary Rate Interface (PRI) lines. By 
adhering to the CAPI 2.0, PC-Telephone uses well-defined mechanism for communications over ISDN 
lines, without being forced to adjust to the idiosyncrasies of the hardware vendor implementation. PC-
Telephone enables automatically the Network-ISDN options if you have a CAPI 2.0 compliant ISDN 
card/modem installed. For the list of the CAPI 2.0 compliant products visit http://www.capi.org.

If you do not have ISDN, use PC-Telephone to make PC-to-Phone/Fax calls over Internet.

If you have SoftDataLink or Fritz!GSM cable kit to connect your mobile phone to your PC or portable 
computer, you can use PC-Telephone to send/receive faxes and files through your mobile phone.



Supported Features

Telephony:
All normal full-duplex telephone operations – enables you to make and receive phone calls PC-to-

PC, PC-to-Phone/Fax, Phone/Fax-to-PC. You can make phone calls using your PC sound card or USB 
telephone device.

Calling Line Identity Presentation/Restriction (CLIP/CLIR) – displays the caller’s number when the 
phone rings (caller ID).

Call Answer –answers automatically incoming phone calls after a specified delay.
Call Scheduling – dials automatically phone/fax numbers at a specified time.
Call Forwarding – forwards automatically incoming phone/fax calls to predefined number.
Call Transfer – transfers an active phone/fax call to another number.
Call Waiting – enables you to switch back and forth between active connections.
Call Accounting – logs all successful phone/fax calls in the Journal. Unanswered calls are logged in 

the Missed     Calls   folder.
Muting – temporarily blocks the remote party from hearing your voice. A playback can be placed on the

line instead.
Audio Conferencing – ensures simultaneous multi-party telephone conversation.
Full-Duplex Recording – records telephone conversations.
Encryption – encrypts telephone calls. This feature is applicable with PC-to-PC calls only, regardless of

the communications network used.

Data Transfer:
Direct Data Transfer – sends/receives files using different communications networks. The data transfer

speed depends on the hardware used (Ethernet Card, ISDN Card, Modem, etc).
Rescheduled Data Transfer – sends automatically the selected file at a specified time to a specified 

number.

Fax Transfer:
Direct Fax Transfer – sends/receives fax documents including analog Group 3 and digital Group 4 

faxes to/from PCs or regular fax machines.
Rescheduled Fax Transfer – sends automatically the selected fax document at a specified time to a 

specified fax number.

Voicemail:
Multiple User Mailboxes – enables you to make mailboxes for your friends or clients leaving voice 

messages for them. They can remotely access their mailboxes by DTMF (Dual Tone Multiple Frequency) 
access code from any regular phone.

Public Mailbox Support – enables you to place public domain announcements in the Public mailbox. 
Together with the Call     Answer   options it turns your PC into an answering machine.

Instant Voice Messages – sends instant messages to any phone by placing an outgoing phone call in 
the Outbox.

Listen Messages Remotely – enables you to listen received new voice messages remotely using a 
regular phone.

Call Screening – enables you to listen to callers as they leave messages. The caller does not hear you.
Limited Message Duration – limits the incoming voice message duration and a start/end tone notifies 

the caller to complete the message.



System Requirements
Hardware:
Pentium 133 MHz or faster CPU
16 MB RAM
Sound Card (full duplex) or USB phone device
Handset/headset or speakers and microphone
Communications network (Ethernet Card, DSL, Cable, ISDN Card or Voice Modem)

Software:
Windows 95/98/98ME/2000/NT4/XP
Windows compatible sound system
Communications network protocol (TCP/IP and/or CAPI 2.0)
WinSock2     update   (for Windows 95 only)



Installation

PC-Telephone is packaged as a self-extracting installation file. Before installing the new version, make 
sure that the old one is not running and uninstall it.

To install PC-Telephone on your computer use the steps as follows:
Run PC-Telephone.exe installation file and follow the instructions.
Run PC-Telephone and customize the default PC-Telephone settings from the Main     Menu   – Options.

PC-Telephone is ready for your First     Phone     Call  .



Main Window

The PC-Telephone Main Window is split in two panes. The left pane displays the Service     Folders   and the 
right pane shows the available items of the selected service folder.

The PC-Telephone functions are available through Main     Menu  . The most important functions are also 
available through Toolbar as well as by the system tray icon - popup menu (see your Windows taskbar).

A special toolbar Phonebar allows handling the incoming and outgoing calls.

At the bottom of the Main Window is the Status Bar where help information and application warnings are 
displayed. The Status Bar indicator shows the calculated duration and cost of the selected calls in the 
Journal.



Main Menu

Most of the PC-Telephone functions are available through the Main Menu. It is located at the top of the 
Main     Window   as shown.

The File menu contains commands for manipulating the PC-Telephone file. This file keeps the whole 
information of the PC-Telephone Service     Folders  . The File menu commands are as follows:

New – creates a new PC-Telephone file.
Open… – opens an existing PC-Telephone file.
Save As… – saves the current PC-Telephone file with a different name.
Import… – imports the Phonebook items from a text file.
Export… – exports the selected items in a text file.
Print… – prints the items of the selected Service     Folder  .
Print Setup… – allows setting the printer options.
Exit – closes the application Main     Window  .

The Edit menu contains commands for the items in the selected Service     Folder  :
Add/Edit/Delete Item – adds a new item, edits or deletes selected items in the current service folder.
Restore Item – restores deleted items from the Waste.
Call Item – places the phone number of the selected item in the Phonebar display for calling.
Link Connections – links the selected active connections in the Connections folder, so they can hear 

each other.

The View menu contains commands for customising the user interface. Use the View menu to show or 
hide the Statusbar, Toolbar and Phonebar.

The Options menu allows setting different PC-Telephone options as follows:
Call Answer – displays the Call     Answer   dialog box.
Call Scheduling – displays the Call     Scheduling   dialog box.
Call Forwarding – displays the Call     Forwarding   dialog box.
Call Transfer – displays the Call     Transfer   dialog box.
Setup – displays the Setup dialog box.

The Network menu allows setting the communications networks options as follows:
IP (Internet) – displays the IP     Options   dialog box.
ISDN – displays the ISDN     Options   dialog box.
PSTN – displays the PSTN     Options   dialog box.
Log Network ID – logs the network ID (IP address or ISDN/PSTN) in the Journal.

The Help menu displays help information (this file) and the About     PC-Telephone   dialog box.



Toolbar

The most important PC-Telephone functions are available through Toolbar buttons. The Toolbar is docked 
at the top of the Main     Window  . Use the Main     Menu   – View to show or hide the Toolbar.

The Toolbar buttons have the following functions:

Opens an existing PC-Telephone file.

Prints the items of the current Service     Folder  .

Displays the Call     Answer   dialog box.

Displays the Call     Scheduling   dialog box.

Displays the Call     Forwarding   dialog box.

Displays the Call     Transfer   dialog box.

Adds a new item in the current Service     Folder  .

Edits the selected item in the current Service     Folder  .

Deletes the selected items in the current Service     Folder  .

Restores deleted items from the Waste.

Places the phone number of the selected item in the Phonebar display for calling.

Links the selected active connections in the Connections folder, so they can hear each other.

Displays context sensitive help information for the selected user interface control.



Phonebar

The Phonebar is a special purpose toolbar used to handle the phone call operations. The Phonebar can 
be docked on the left or right of the Main     Window   or can also be displayed in a separate window as 
shown. To show or hide the Phonebar use the Main     Menu   – View or the PC-Telephone system tray icon - 
popup menu (see your Windows taskbar).

The Phonebar has a display, service buttons (Voice, Data and Fax), scroll buttons, dial pad and call 
handle buttons (Dial/Answer, Cancel, Record, Encryption and Talk/Mute).

The Phonebar display has three areas. At the top of the display a telephone number is entered. In the 
middle is the remote party’s name if known and at the bottom is the call status information. A phone 
number can be entered directly in the Phonebar display by the computer keyboard. If the phone number 
matches one in the Phonebook the corresponding name displays automatically. You can also type in the 
Phonebar display the name of the party you like to call. The corresponding phone number displays 
automatically if the name you type is in the Phonebook.

The IP address is used as a phone number in the Internet. When you enter an IP address 
(213.253.219.194) or a domain name (pctt.net) in the Phonebar, PC-Telephone recognizes the 
corresponding call as a PC-to-PC call over Internet/Intranet.

Use digits only when you dial regular phone/fax numbers. The regular phone calls (PC-to-Phone/Phone-
to-PC calls over ISDN) are directed to the ISDN telephone network through your ISDN modem.

You can also transfer your regular phone/fax calls through a PC-Telephone gateway – PC-to-Phone/Fax 
calls over Internet.

The Phonebar service buttons Voice, Data and Fax are used to specify the call service. For Data and Fax 
services an Open File dialog is displayed where the corresponding data or fax file (*.sff – Structured 
Fax File format) have to be selected.

The Phonebar dial pad is used for typing a phone number as well as for sending DTMF tones to the 



current active connection. Use the Connections folder or the Phonebar scroll buttons to look through the 
active connections.

At the bottom of the Phonebar are the speaker and microphone volume controls where the levels of the 
audio signal are adjusted. You can also do this by the Volume Control of your Sound     Card  .

The call handle buttons have the following functions:

Dial/Answer – initiates a connection with the phone number or the IP address entered in the Phonebar 
display or accepts the selected incoming call.

Cancel – cancels the current connection or rejects the selected incoming call.

Record – records the current telephone conversation. The recorded telephone conversation can later be 
replayed from the Journal.

Encryption – encrypts the current call. The encryption is applicable with PC-to-PC calls only regardless 
of the network used.

Talk/Mute – blocks the remote party from hearing your voice. A playback can be placed on the line 
instead (see Setup – Call     Notification  ).

The call progress messages that will notify you on the Phonebar display are as follows:

Calling… – an outgoing call is pending, waiting for the called party’s answer.

Incoming Call  (RING) – an incoming call waiting for your answer.

Cancelled – sometimes if the destination you call is overloaded or the calling phone number is currently 
busy you may get this message. Please, try to call later and make sure you have a correct phone number.

No Answer – an outgoing call failed because the PC you are calling is not currently online or the PC-
Telephone is not running on that PC.

Wrong Number – an outgoing call failed because the phone number or the IP address is wrong. The 
regular phone numbers should consist of digits only.

No Network – an outgoing call failed because the corresponding communications network is unavailable, 
Internet/Intranet for IP calls, ISDN/PSTN for regular phone calls.



FaxView

FaxView is the PC-Telephone fax viewer. Use FaxView to view or print received faxes and preview 
outgoing faxes. PC-Telephone stores each fax document in a separate fax image file *.SFF (Structured 
Fax File format). You can start FaxView from the Journal as well as like any other program running on 
your operating system.

With FaxView you can view the fax pages with the actual size, fit them to the width or height of the 
FaxView window, rotate the current page and save the document with a new name. You can also browse 
through multiple-page faxes and print the entire fax document or selected pages.

The FaxView functions are available through the main menu. The most important functions are also 
available through the toolbar. At the bottom of the main window is the status bar where help information 
and the number of the current page are displayed.



Phone Calls

PC-Telephone enables you to make phone calls PC-to-PC, PC-to-Phone/Fax, Phone/Fax-to-PC and 
Phone-to-Phone by Call Forwarding/Call Transfer. Before making your first phone call, make sure that the
Sound     Card   of your computer is working properly and you have the corresponding communications 
network available – Internet, ISDN or PSTN.

First Phone Call
You do not need a remote party in order to try out your first phone call. Type localhost at the top of the 
Phonebar display and press the Dial button. Two connections (incoming and outgoing) will be placed into 
the Connections folder. Select the incoming one and press the Dial/Answer button to accept it. You will 
hear your voice back, because you are calling yourself.

Outgoing Calls
To make a phone call:
Select the Voice service from the Phonebar.
Type the phone number or the IP address of the party you like to call in the Phonebar display.
Press the Dial/Answer button to start calling.

A new outgoing connection appears in the Connections folder. The selected Call     Notification   and the 
“Calling…” message on the Phonebar display notify you about the progress of the outgoing connection.

When the called party answers the call, the connection changes its status from “Pending” to “Talk” and 
displays the elapsed time on the Phonebar.

Use the Outbox and Call     Scheduling   to schedule your outgoing phone/fax calls or instant voice 
messages.

Incoming Calls
The incoming calls are automatically placed into the Connections folder. The Call     Notifications   you have 
selected and the (Ring) message on the Phonebar display notify you about the incoming calls.

To answer (accept) an incoming call:
Select an incoming connection in the Connections folder. The incoming connections are automatically 

selected, if there is no active connection displayed on the Phonebar.
Press the Dial/Answer button to accept the selected incoming connection.

The connection changes its status from “Pending” to “Talk” and displays the elapsed time on the 
Phonebar.

To reject an incoming call, use the Cancel button on the Phonebar.

Use Call     Answer   to answer the incoming calls automatically.

Active Connections
The Connections folder displays the active connections. Use the Phonebar scroll buttons to look through 
the active connections.

The Phonebar buttons Record, Encrypt and Talk/Mute are used accordingly to record, encrypt or mute the
current telephone conversation.

To cancel/close an active connection:
Select a connection in the Connections folder.
Press Cancel button to close the selected connection.

The successful calls are logged into the Journal.





Data Transfer

PC-Telephone enables you to send and receive files. The data transfer is possible with PC-to-PC 
connections only. The data transfer speed depends on the speed of the communications hardware used 
(Ethernet Card, ISDN Card or Modem).

To send a file:
Press the Data service button on the Phonebar and select the file you like to send.
Type the phone number or the IP address of the remote party computer on the Phonebar display.
Press the Dial button to establish the connection.

A new data connection appears in the Connections folder. When the called party accepts the connection, 
the file transmission starts. The connection will be automatically closed after the file has been 
successfully sent.

Use the Outbox and Call     Scheduling   to schedule your outgoing data transfer.

To receive a file, accept the corresponding incoming data connection. Use Call     Answer   to receive files 
automatically.

The successful data connections are logged into the Journal.



Fax Transfer

Use the PC-Telephone fax service to send and receive fax documents including analog Group 3 and 
digital Group 4 faxes. The SFF (Structured Fax File) format is used in the fax image files.

To send a fax:
Press the Fax service button on the Phonebar and select the fax image file you like to send. Use the 

PC-Telephone Fax Printer to make your fax documents with any Windows application like Notepad, Word,
Excel, Write, WordPad, Imaging, etc.
Type the fax number or the IP address of the remote party fax machine/computer in the Phonebar 

display.
Press the Dial button to establish the connection.

A new fax connection appears in the Connections folder. When the remote fax machine accepts the call, 
the fax transmission starts. The connection is automatically closed after the fax has been successfully 
sent.

Use the Outbox and Call     Scheduling   to schedule your outgoing fax transfer. When you print your 
documents on the PC-Telephone Fax Printer, the Outbox is automatically displayed where you can enter 
the destination fax number or IP address and send your fax over Internet or ISDN/PSTN.

To receive a fax, accept the incoming fax call. Use Call     Answer   to receive faxes automatically.

The successful fax connections are logged into the Journal, where the fax documents can be viewed and 
printed by FaxView.

Note: In order to receive faxes originating from fax machines connected to analog PSTN lines make sure 
that your fax number is entered correctly in the ISDN     Options   dialog box.



Service Folders

Connections
Journal
Outbox
Phonebook
Voicemail

 Mailbox
Waste
Missed     Calls  
The PC-Telephone file contains several service folders. The left pane of the Main     Window   displays the 
service folders and the right pane shows the available items of the selected service folder.
There are different types of calls according to the service used (Voice, Data or Fax). The following icons 
distinguish the folder items according to their service:
 – phone call.
 – recorded phone call.
 – new voice message.
 – voice message.
 – new data file.
 – data file.
 – new fax message.
 – fax message.

Use the Main     Menu   – File or the Toolbar buttons to create, open or save a PC-Telephone (*.tel) file.



Connections

The Connections folder holds the active connections. Every incoming and outgoing call appears here first 
and is available in the Connections folder as long as it is active. After disconnecting, the successful calls 
are stored in the Journal and the missed calls are stored in the Missed     Calls   folder.

Use the Connections folder or the Phonebar scroll buttons to look through the active connections. The 
selected connection displays in the Phonebar.

The connection properties are as follows:
Service – the connection service (Voice, Data or Fax) shown by a corresponding icon (see 

Service     Folders  ).
Name – the remote party name from the Phonebook.
Phone – the remote party phone number or IP address.
Time – the connection time.
Duration – the elapsed connection time.
State – the connection state (Pending, Connect or Talk).
Direction – the connection direction (Incoming/Outgoing).
Network – the connection network ID (IP address or ISDN/PSTN).



Journal

All successful incoming and outgoing phone calls are logged into the Journal. Use the Main     Menu   – Edit 
or the Toolbar buttons to edit, delete or call Journal items.

The Journal dialog box is used to access the Journal item properties. Here you can preview faxes, open 
or copy data files, replay voice messages and recorded telephone conversations.

According to the service used (Voice, Data or Fax) a corresponding button will be available reading 
Play/Stop, Open     with…   or View.

The items in the Journal can be deleted automatically after specified period (see Setup – Deletion).



Open with…

The “Open with…” dialog box is used to open the transmitted data files in the Journal by the selected 
Windows application - Notepad, Word, Excel, etc.

Select the application you would like to use to open the file and press the OK button.



Outbox

The Outbox is the place where you can schedule your outgoing calls, instant voice messages, fax or data 
transfer. When the Call     Scheduling   is enabled, PC-Telephone automatically dials the available items in 
the Outbox. If the outgoing call is successful, the item is moved from the Outbox to Journal. Otherwise, 
PC-Telephone decreases the Retries counter of the item and reschedules the dial-out Time by the Retry 
Interval parameter (see Call     Scheduling  ).

Use the Main     Menu   – Edit or the Toolbar buttons to add, edit, delete or call Outbox items.

The Outbox dialog box is used to enter the Outbox item properties. When you print your documents on 
the PC-Telephone Fax Printer, the Outbox is displayed automatically where you can enter the destination 
fax number or IP address, set the time when the call should be automatically dialled, the number of retries
and press the OK or Send Now button in order to place the outgoing call.

If the selected service is Data or Fax, a filename should be provided for the file to be transferred.

Here you can also record instant voice messages (Voicemail) to be sent to any phone at a specified time.

Press the Open button to select a wave file (*.wav) as a voice message. Only PCM-16bit-mono wave 
files are compatible with the PC-Telephone audio system.

You can also record a voice message by Windows Sound Recorder. Select Edit – Audio Properties to set 
the audio format to PCM 8000 kHz, 16 Bit, Mono. Use Sound Recorder to convert wave files from one 
format to another (File – Save As – Change).

Set the attributes of the file you have recorded to Read Only if you like to send it to several recipients 
unchanged.



Phonebook

The Phonebook is your telephone directory. Here you can store the telephone numbers or IP addresses 
of your friends or customers. Use the Main     Menu   – Edit or the Toolbar buttons to add, edit, delete or call 
Phonebook items.

The Phonebook dialog box is used to enter the Phonebook item properties. Enter a name, a phone/fax 
number or an IP address and select a service (Voice, Data or Fax) for the number entered.



Voicemail

The Voicemail folder is used to store mailboxes. Here you can create mailboxes for your family, friends or 
customers. You can also create mailboxes for various information services you provide. Use the 
Main     Menu   – Edit or the Toolbar buttons to add, edit or delete mailboxes.

There is a Public Mailbox where common announcements are placed. If the “Use Voicemail” option is 
selected (see Call     Answer  ), PC-Telephone automatically answers the incoming phone calls and plays the 
public announcements first. When the caller types a mailbox access code, the available voice messages 
in the corresponding Mailbox are played as well. If there are no more messages to be played, a beep 
notifies the caller to leave a message.

The duration of the incoming voice messages is limited and the last ten seconds notify the caller to 
complete the message (see Setup - Audio).

The received voice messages are logged into the Journal. Use the Public mailbox access code to hear 
the received new messages from a regular phone.

The Mailbox dialog box is used to enter the mailbox properties. Type a mailbox name (usually the name 
of the mailbox owner) and choose a unique access code, which is used by the mailbox owner to hear the 
available voice messages.

The access code ranges from 0101 to 9898 and is encoded by DTMF (Dual Tone Multi Frequency) 
telephony standard in order to extend the voicemail application to the regular phones. Use different 
subsequent digits to increase the reliability of the DTMF detection.



Mailbox

The Mailbox is the place where you leave messages for the mailbox owner. The mailbox owners are 
usually your family, friends or customers, but you can also make mailboxes for the information services 
you provide.

Every voice message has a name, a seal time, duration and a status. Only the active messages are 
played by the PC-Telephone in the order of the seal time. Once the mailbox owner has heard the 
message, it unseals.

Use the Public mailbox to leave public domain announcements: greetings in different languages, 
instructions, etc. A public announcement could be the following example: “No one is available to take your
call right now, type your mailbox code or leave a message at the tone.”

Use the Main     Menu   – Edit or the Toolbar buttons to add, edit or delete voice messages.

The Voice Message dialog box is used to create voice messages. Use the Record and Play buttons 
accordingly to record and replay voice messages.

Press the Open button to select a wave file (*.wav) as a voice message. Only PCM-16bit-mono wave 
files are compatible with the PC-Telephone audio system.

You can also record a voice message by Windows Sound Recorder. Select Edit – Audio Properties to set 
the audio format to PCM 8000 kHz, 16 Bit, Mono. Use Sound Recorder to convert wave files from one 
format to another (File – Save As – Change).



Waste

The Waste folder is used as wastebasket. The deleted items from other Service     Folders   are temporarily 
stored here. Use the Main     Menu   – Edit or the Toolbar buttons to edit, restore or permanently delete the 
items in the Waste folder.

The items in the Waste folder can be automatically deleted when PC-Telephone exits (see Setup – 
Deletion).



Missed Calls

The Missed Calls folder is used to log the missed calls. When an incoming call is pending and the calling 
party cancels the connection before you answer it, then you miss the call.

The Missed Calls folder is available only if there are missed calls.

The items in the Missed Calls folder can be deleted automatically after specified period (see Setup – 
Deletion).

Use the Main     Menu   – Edit or the Toolbar buttons to delete or call back the missed calls.



Call Answer

When the Call Answer is enabled, PC-Telephone automatically answers the incoming calls. Use the 
Main     Menu   – Options or the Toolbar to display the Call Answer dialog box.

Enable the Call Answer for the service you like (Voice, Data or Fax) and specify the delay interval after 
which incoming calls are automatically answered.

When the “Use Voicemail” option is selected, PC-Telephone answers the incoming phone calls and plays 
the announcements in the Public Mailbox.

Select “Call Notification” if you like to be notified about incoming calls when the Call Answer is enabled 
(see Setup – Call     Notification  ).



Call Scheduling

When the Call Scheduling is enabled, PC-Telephone automatically dials the available items in the Outbox.
Use the Main     Menu   – Options or the Toolbar to display the Call Scheduling dialog box.

The “Wait for answer” time interval is used to wait for the called party’s answer before call cancellation.

The “Retry interval” is used to reschedule the dial-out Time of the Outbox item when the connection is 
cancelled.

Select “Call Notification” if you like to be notified about the progress of the outgoing calls when the 
Call Scheduling is enabled (see Setup – Call     Notification  ).



Call Forwarding

When the Call Forwarding option is enabled, PC-Telephone automatically forwards all incoming calls to 
the predefined phone numbers or IP addresses. Use the Main     Menu   – Options or the Toolbar to display 
the Call Forwarding dialog box.

Enter the phone number or the IP address where all incoming phone calls are forwarded to. You can 
specify different destinations for the different services - Voice, Data and Fax.

Select “Call Notification” if you like to be notified about incoming calls when the Call Forwarding is 
enabled (see Setup – Call     Notification  ).

Select “Auto Cancellation” if you like to cancel/disconnect the forwarded incoming call when the 
corresponding outgoing call has been cancelled.

Hint: If “Auto Cancellation” is unchecked and the outgoing call has been cancelled the corresponding 
incoming call will be answered by the Voicemail if the Call     Answer   is enabled.

Select “Make Record” to record the telephone conversation when a Voice call is forwarded or to make a 
copy of the file/fax transmission when a Data/Fax call is forwarded.



Call Transfer

Use Call Transfer to make your own PC-Telephone gateway between Internet/Intranet and the public 
telephone networks ISDN/PSTN. When the Call Transfer option is enabled, PC-Telephone automatically 
transfers incoming calls to the corresponding phone/fax numbers or IP addresses. See PC-to-Phone/Fax 
calls over Internet how to make your regular phone calls through a PC-Telephone gateway.

The incoming phone number, which should be transferred, must be formatted as address1#address2, 
where address1 is the calling party IP address (caller ID) and address2 is the called party IP address 
or phone/fax number the call should be transferred to.

Use the Main     Menu   – Options or the Toolbar to display the Call Transfer dialog box.

Select the phone calls you like to allow your PC-Telephone to transfer:

Local calls – numbers beginning with no zero (9876543);

Long distance calls – numbers beginning with one zero (098765432);

International calls – numbers beginning with two and more zeros (00987654321);

IP calls – Internet addresses (213.253.219.194 or pctt.net).

The third state (the greyed out) of the selected check box enables the call transfer only for the numbers in
the Phonebook. In this way you can restrict the call transfer for unknown phone numbers.

You can also reject the call transfer for the phone numbers beginning with specific digits (use comma 
separated list).

Select “Call Notification” if you like to be notified about incoming calls when the Call Transfer is enabled 
(see Setup – Call     Notification  ).

Select “Auto Cancellation” if you like to cancel/disconnect the transferred incoming call when the 
corresponding outgoing call has been cancelled.



Hint: If “Auto Cancellation” is unchecked and the outgoing call has been cancelled the corresponding 
incoming call will be answered by the Voicemail if the Call     Answer   is enabled.

Select “Make Record” to record the telephone conversations when a Voice calls is transferred or to make 
a copy of the file/fax transmission when a Data/Fax call is transferred.



Setup – Startup

Use the Main     Menu   – Options to display the Setup dialog box where the Startup options are specified.

Select “Launch at Windows startup” if you like PC-Telephone to be automatically started when Windows 
starts.

Select “Leave in system tray on exit” to leave PC-Telephone in the system tray when the Main     Window   
closes (see the Windows taskbar).

Select “Show PC-Telephone on the desktop” to create a PC-Telephone shortcut on your Windows 
desktop.



Setup – Audio

Use the Main     Menu   – Options to display the Setup dialog box where the Audio options are specified.

Select the audio device you like to use with your PC-Telephone. If you have an USB telephone device 
connected to your PC, the corresponding USB audio and USB phone devices will also be available for 
selection.

Specify the limit of the incoming voice message duration (0-120 seconds).

Select “Listen to callers as they leave messages” to enable the call screening. When this option is 
enabled you can hear the remote parties as they leave voice messages, but they will not hear you. You 
can always take over the screened active connection by the Talk/Mute button on the Phonebar.



Setup – Call Notification

Use the Main     Menu   – Options to display the Setup dialog box where the Call Notification options are 
specified.

Select the notification you like to use when incoming or outgoing calls are in progress.

Press the Default button to use the default sound for the selected call notification or customize it by the 
available sound recorder.
The events that will be notified are:

Incoming ring – plays the selected sound every ten seconds when an incoming call is pending.
Outgoing tone – plays the selected sound every ten seconds when an outgoing call is pending.
Playback on mute – plays the selected sound through the line as long as the connection is muted (see 

Phonebar).
PC speaker – uses the PC speaker to notify you about incoming calls (for registered users only).
USB phone – uses the USB phone device available to notify you about incoming calls (for registered 

users only).
Popup Phonebar – pops up the Phonebar when an incoming/outgoing call is pending.



Setup – Deletion

Use the Main     Menu   - Options to display the Setup dialog box where the Deletion options are specified.

Select “Confirm manual deletions” in order to avoid items to be accidentally deleted. The deleted items 
can be restored from the Waste folder.

Select “Empty the Waste folder upon exiting” to automatically delete the available items in the Waste 
folder when PC-Telephone exits.

Select the items to be automatically deleted from the Journal and Missed     Calls   folders and specify the 
expiration period. The expired items are permanently deleted on hourly basis.



Sound Card

The Volume Control system tray icon is used to display the playback and recording volume controls (see 
the Windows taskbar). In order to hear the remote party the Wave channel must be selected (not muted). 
The Microphone channel must be muted accordingly to avoid the echo effect.

Use the menu Options – Properties, as shown, to display the sound card Recording Control where the 
Microphone channel must be selected (not muted) to allow the remote party to hear your voice.

Adjust the levels of the Wave and Microphone channels to reach the best sound quality of your telephone 
conversation. The Wave playback and Microphone recording channels can be also controlled by the 
Phonebar.

Some sound cards may have different playback and recording properties. Use the Control Panel to 
access your sound card properties.

In order to have a normal telephone conversation, only full-duplex sound cards are supported by PC-
Telephone. Most of the sound cards on the market are full-duplex. To verify that you have a full-duplex 
sound card, run two instances of the Windows Sound Recorder and try to make a record by the one while



playing wave file on the other.



IP Options

Using Internet as a communications network you have unlimited, free, long-distance PC-to-PC calls with 
enhanced audio quality and reliable data/fax transfer. You can also transfer your regular phone/fax calls 
through a PC-Telephone gateway (see PC-to-Phone/Fax calls over Internet).

Introducing the advanced Voice     over     TCP/IP   technology PC-Telephone works with all Firewalls, NAT and 
LAN routers – nothing to configure. In this way you can make free PC-to-PC and cheap PC-to-Phone/Fax 
calls from your LAN computer.

PC-Telephone enables the IP options if you have TCP/IP protocol installed.

Use the Main     Menu   – Network to display the IP Options dialog box.

Enter your PC-Telephone gateway and calling card number in order to make PC-to-Phone/Fax calls over 
Internet. Your calling card units are automatically updated when you complete a phone call.

Select your default PC-Telephone gateway to avoid entering the IP address with the phone number 
(pctt.net#1234567890). When you dial #1234567890 your phone call will be placed through the default 
PC-Telephone gateway you have selected.

Select your IP address in order to be identified by the called party. When you make PC-to-PC calls, this 
address is used as caller ID. Your computer name is used by default.

In the “IP address” combo box you can also find your current IP address, which should be used by the 
remote party to call you. You might have more than one IP addresses according to the Internet/Intranet 
connections you have – Dialup, DSL/ADSL, LAN, etc.



Voice over TCP/IP

The advanced Voice over TCP/IP technology implemented in PC-Telephone enables you to make calls 
even when your PC is behind a Firewall, NAT and LAN router – nothing to configure.

You can make calls directly from your Local Area Network (LAN) computer. As long as you have Internet 
and access websites you can also make unlimited, free PC-to-PC calls and cheap PC-to-Phone/Fax calls 
over Internet with enhanced audio quality and reliable data/fax transfer.



ISDN Options

The Integrated Services Digital Network (ISDN) technology implemented in PC-Telephone turns your 
computer into an ISDN digital telephone. Using ISDN as a communications network you can make PC-to-
Phone/Fax and Phone/Fax-to-PC calls over ISDN.

PC-Telephone enables the ISDN options if you have a CAPI 2.0 compliant ISDN card/modem installed. 
For the list of the CAPI 2.0 compliant products visit http://www.capi.org.

Use the Main     Menu   – Network to display the ISDN Options dialog box.

In the “Controller support options” you can find the supported protocols of your ISDN controller/card. If 
your ISDN controller does not support the necessary protocols, you cannot use the corresponding 
service.

For telephony the ISDN card should have B1 – 64 kbit/s bit-transparent with network byte framing, B2 – 
Transparent and B3 – Transparent protocols.

For data transfer your ISDN card should have the protocols: B1 – 64 kbit/s with HDLC framing, B2 – ISO 
7776 (X.75 SLP) and B3 – Transparent.

For fax G3 your ISDN card should have B1 – T.30 modem for Group 3 fax, B2 – T.30 for Group 3 fax, B3 –



T.30 for Group 3 fax protocols.

Select the voice compression used in your local ISDN exchange:

CCITT G.711 A-Law – used in DSS1 and 1TR6 networks (Europe, Asia, Africa, Australia, South 
America).

CCITT G.711 u-Law – used in AT&T 5ESS and NI-1 networks (North America and Japan).

Enter your phone and fax numbers (coma separated list without the area codes) to enable your PC-
Telephone to listen for the corresponding incoming phone/fax calls. When you place regular phone calls, 
these numbers are also used as caller IDs if the CLIP/CLIR check box is selected and your ISDN network
supports Calling Line Identity Presentation/Restriction services.

Leave the phone number field empty if you like your PC-Telephone to listen for and receive all incoming 
calls from the ISDN line. Your main ISDN number will be used as a caller ID in this case.

Enter your fax number in order to receive fax calls originated from fax machines connected to analog 
PSTN lines.

Use the call transfer list in order to transfer incoming calls by the called (MSN) number. In this way your 
PC-Telephone works like a telephone exchange (PBX) transferring incoming regular phone/fax calls to the
corresponding IP addresses in your LAN or WAN. The call transfer list should look like:

9876511 => pc1
9876512 => pc2.yourname.net:fax
9876513 => 213.253.219.194:data
9876514 => 1234567
9876515 => pctt.net#1234567890
…

The Call     Transfer   options should be enabled in order to transfer the incoming calls.

Use the “Prefix” field to enter the digits you like to insert to the outgoing phone/fax numbers.



PSTN Options

The Public Switched Telephone Network (PSTN) is the classic analog telephone network. Using PSTN as
a communications network you can make and receive phone calls to any regular phone with excellent 
audio quality and reliable data and fax transfer.

The Telephony-API (TAPI 3.0) is an Application Programming Interface standard used to access analog 
voice modems connected to PSTN lines.

Note: TAPI 3.0 is currently not supported by PC-Telephone. You can, however, make and receive calls 
to/from regular phones connected to analog PSTN lines through your ISDN connection, because ISDN 
and PSTN are routed to each other in your local telephone exchange. Using ISDN line you could in fact 
call and communicate with any other device anywhere irrespective of protocols or standards used if 
appropriate interconnect arrangements are in place.

Use your Internet connection to make PC-to-Phone/Fax calls over Internet.



Registration Information
As a registered PC-Telephone user, you:
Use PC-Telephone without the limitations of the evaluation copy as explained in the PC-Telephone 

License     Agreement  .
Access support and assistance at support@pc-telephone.com.
Are entitled to a special upgrade price for all new PC-Telephone releases.
Are entitled to free PC-to-Phone/Fax calls through our PC-Telephone gateway in amount of 5000 units.

Registration procedure:
Send an order using one of the options as described in the PC-Telephone website: http://www.pc-

telephone.com.
Upon receipt of your registration fee you will receive, by the email address you provide, a unique 

registration key, which corresponds to your name and email address strings given in the registration form.
Enter your name, email address and license key in the About PC-Telephone dialog box and press the 

OK button. Use the same letters for your name and email address as you provide them in the registration 
form.

The registration is a subject to the PC-Telephone License     Agreement  .

Should you have any questions concerning the registration procedure, please contact us at sales@pc-
telephone.com.

Use the Main     Menu   – Help to display the About PC-Telephone dialog box.



Trademarks
PC-Telephone and the PC-Telephone logo are registered trademarks and registered service marks of 
Selectra Ltd.

Microsoft, Windows and Windows NT are either trademarks or registered trademarks of Microsoft 
Corporation.

Intel and Pentium are registered trademarks of Intel Corporation.

Other product and company names mentioned herein may be trademarks and/or service marks of their 
respective owners.



Licensed
Dear User,

Your PC-Telephone copy is successfully registered!
As a registered PC-Telephone user, you may use your PC-Telephone without the limitations of the 
evaluation copy. You are also entitled to a special price for all new PC-Telephone releases. You also have 
free PC-to-Phone/Fax calls through pctt.net# in amount of 5000 units.

When you finish your free units use our calling cards to recharge your PC-to-Phone/Fax calling account.

You may also access support and assistance at support@pc-telephone.com. Please, use your license 
key as a reference in the emails.

The registration is a subject to the PC-Telephone License     Agreement  .

Should you have any questions concerning the License Agreement, or if you desire to contact us for any 
reason about PC-Telephone, please contact us at mail@pc-telephone.com.

Thank you for using the original PC-Telephone!




